
The Communicator module is an addition to the SHIELD system that allows for remote 
interface to the Emergency Communication System. 

The Communicator dials out and allows a remote Call Center to talk and listen to the 
person in front of the Remote Call Station using a standard phone line.

SHIELD Communicator
Configuration Instructions
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It is recommended to send along the appropriate call sequence (Section 1.3, "Communicator Module Connections" ) and a zone 
list to the Call Center to attach to the account for the Phone Operator to see while answering a call. 

Note: If the call is NOT reset, the system will keep dialing the number until it has 
been properly reset. This is to ensure the call is not dropped or interrupted and a 
pathway back to the remote's location is not lost. 

Description:
The purpose of  the Communicator is to enable the ability for the system to dial off-site with a voice connection to the Remote Call 

Station in an alarm. 

The Communication is half duplex. This means the Phone Operator can only either talk or listen, not both 
simultaneously. In order to switch between the Talk / Listen functions, press the asterisk / star key " * " on the keypad. To 
acknowledge and reset the call, press " 1 ".

Command Panel P/N SCOMM1 
Communicator 

192.168.1.100
Note. this part number is included in 

the SM30 Command Panel. 

System-Dialer-Default-100.cfg
OR

System-Dialer-Default-ContactID-100.cfg

Remote Call Stations Call Center

INTRODUCTION



1.1:  Requirements

This Communicator requires an Analog phone line. This may be supplied by the phone company, internet provider as a 
service, or via an analog terminal adapter. 

To set up the Communicator, there are two things that must be done before hooking up the device. If you do not have access to install 
programs on your computer or make changes to your network adapter, see your IT administrator ahead of install. Ensure the computer being 
used has the DOWN Program installed. 
The DOWN Program is available for download, see (Section 8, "Resources" . Set your computer to a static IP Address to match and use the 
same network as the Communicator. The default IP Address is printed on a sticker on the Ethernet port of your SHIELD device. The 
Communicator is configured by a computer using a standard Ethernet cable.

In order to set up the Communicator, five messages must be recorded and downloaded to the module. These messages may be done 
ahead of time. A recording device, such as your phone, is required to capture the messages. The Communicator will keep these messages even 
if the system is powered down. 

1.2: Messages

Message 0 should announce the main address. Example:
"This is an emergency call from Boston, Acorn St. 1."

Message 1 should be "Operator Talk"

Message 2 should be “Operator Listening"

Message 3 is the verification message that plays when pressing the ' 1 ' key the first time. "Press ' 1 ' again to acknowledge and end the call." 

Message 4 not used

Message 5 is the message that will be played to the Central Station Operator, giving instructions on how to use the half-duplex mode.
"Press the Star key to Talk, and the Star key to listen. Press the '1' key to end communication, and the '1' key again to acknowledge 
and end the call.".  This message must be played all the way through before the call will finally reset.

Before setting up your system, contact the Call Center.

1. About the Communicator





SPECS AND DETAILS 

• Mounts in SHIELD30 Master Command Panel or Communicator Enclosure (sold separately)
• Allows emergency calls to be sent to a standard POTS Phone Line
• Set up Site-specific Messages and Instructions

o Refer to (Section 2.1, "Messages") in this current document

• RJ-45 Ethernet Port connects Communicator with Command Panel
• Supports voice calls and Contact-ID with Voice

o Refer to (Section 2.2b, "Configuring the System") in this current document
o Refer to SHIELD30-Emergency-Communication-System-Operations-Manual

 (Section 7.2, "Testing")

• Test Call Button - Calls to POTS Phone Line
• Operates off system 24V Regulated DC Power
• With all DIP Switches set up, uses stored memory. With them down, switches to factory settings, with the IP

Address changing to ".91". Reset the Dialer or System to apply settings.

RJ-11 Jack 
Standard POTS LineRJ-45 Jack

Ethernet

Default
MAC Address

IP Address	
On Hook

LED

24V DC

NOT USED. 
DO NOT CONNECT

Test Call Button

Processor	Active	LED	
(In	normal	operation	will blink approximately once every 2 seconds)

Remote	PC	Supervision	LED	
(Normally off,	on	for	approximately	20	seconds	after reset)

Power	LED

1.4: The Communicator

+
-

+
-

DIP Switch
(Resets IP to Factory Default)

NOT USED. 
DO NOT CONNECT

A UL497A protector is required 
to be installed on the POTS line 
before leaving the building.



A COPY OF THIS PAGE IS AVAILABLE
AS THE LAST PAGE OF THIS MANUAL.

THE COPY AT THE END  IS TO BE GIVEN TO THE  CALL 
CENTER OPERATOR

1.5: Sequence of Operation

1. Call from Remote Call Station is placed.
2. Communicator dials number in Configuration File.
3. Operator picks up call.
4. Communicator in Command Panel starts playing Message 0, followed by Message 5.
5. The minimum required Voice Loops will force the Messages to play a certain number of times before they can be interrupted before

proceeding the call.

6. Operator listens to message and uses asterisk ' * ' key to talk.
7. Operator communicates with user at Remote using the ' * ' key. Each time the ' * ' is pressed the Operator hears Message 1 if they enable Talk, or

Message 2 if they enable Listen.
8. Operator presses' 1 ' key to stop communication. Message 3 is played. Operator presses'1'key again to acknowledge and end the call.

Note: These messages will repeat if no input is given. 

Note: If the' 1 ' key is not used to confirm ending the call, the system will re-dial the number until the call is acknowledged. 

For Messages and their contents, refer to 
Section 1.2, "Messages" in the SHIELD30-Communicator-Configuration-Instructions manual.

Call Sequence: ( Non contact-ID ):



2.1: Messages

Messages are recordings that are stored in the 
Communicator and play on a POTS Phone Line to provide instructions and vital information 
to the Central Station.

2.1a: Description

Recording messages may be done in many different ways. 
The message downloaded to the Communicator must be 
in the following format:
8Khz, 16bit,  Mono, export as .wav

Content of the messages is described in (Section 1.2, "Messages"). 
The end user or Central Station and AHJ should be consulted to determine the content of the messages.

Many applications may be used to generate the files, but you must 
have control to save in the 8000hz, 16bit, .wav format.
Recording can be done with a microphone or a smartphone. It's best to record messages in a quiet area. Once the messages 
have been recorded, import them to Audacity or an audio program of your choosing.
Trim any 'dead air' in the beginning and / or end of the recording. 'Dead air' only adds unnecessary time to the playback. 
Change the bitrate to match the requirements for the Communicator.
For each message, it is best to have a clear, distinct recording with no extra dead space. Using a smartphone to record then 
save to your computer is a great option to get a clear recording, and then trim and format appropriately in Audacity.

Steps to complete audio messages:
A. Record and trim messages (creates appropriate .wav files)
B. Convert to processor or format (convert .wav to .son files)
C. Upload messages to communicator.

2. Starting the Configuration Process



Audacity is a free, easy-to-use, multi-track audio editor and recorder for 
Windows, MacOS, GNU/Linux and other operating systems. 

You may use ANY software available that can generate audio files 
with the correct sampling and bit rate.

•Download and Install Audacity.
https://www.audacityteam.org/download/

For Setup follow all of the defaults:

• Before Starting Audacity, create a folder in
C:\visar\  called ‘umessage’. This directory will
be used to store all voice messages to be
uploaded.

• Once you start Audacity, open the ‘Edit’ menu
and then choose
‘Preferences...’   ( at the very bottom)

• Under the ‘Devices’ section,
make sure the ‘Channels’ is set to 1 (Mono)

Note: The message format before you convert it 
for the Communicator must be in the following 
format: 8Khz, 16bit,  Mono, .wav

2.1b: Recording Messages



*** The files MUST be stored in the  “C:\visar\umessage”  directory!
• Once	the	File	is	saved,	repeat	this	process	for	message	1, 2,	3, 4 and 5.

Example Messages. See (Section 2.1e, "Upload Messages with Number Announcement" ) for full examples:

Message 0: Main Address. "This is an emergency call from Boston, Acorn St. 1" 
Message 1: “Operator Talk”.
Message 2: “Operator Listening”. 
Message 3: End of Call. "Press '1' key again to end the call".
Message 4: Not used.
Message 5: Instruction message "Press the Star key to Talk, and the Star key to listen. Press the '1' key to end

       communication, and the '1' key again to acknowledge and end the call."

RecordPlay Stop

• Next click on the ‘Quality’ section.

• Change the Sample Bitrate to 8000Hz

• Change the ‘Default Sample Rate’ to 16bit.

• Click on the ‘OK’ button to close the preferences.

• You may now record the Audio.

• Once you record the audio, save in the
“C:\visar\umessage” directory as a .wav file

Project Rate (Hz):
Make sure to set this to 
8000Hz before exporting 
your Message!



If you already have made recordings, such as on a different program or device, the recordings will need to be converted and exported in the 
appropriate format as specified above: Mono, 16-bit, 8000Hz, .WAV format.

Note: Most programs and modern devices will record audio in Stereo instead of Mono.

To convert recordings from Stereo to Mono:

*Drag and drop the recording into Audacity.
Since this is a Stereo Track, it will appear as two lines.

*Towards the left, on the Track, click on
the small black arrow and a drop-down
menu will appear. Select 'Split Stereo to
Mono'.

The Track will now split into two 
separate Tracks, creating Mono Tracks.

*Delete one of them by clicking the little 'X'
on the Track across from the arrow.

To ensure the recording has been converted to the appropriate format, a quick way to tell is to refer to its file size. Depending on how long the 
recording is, if the Mono .WAV file is less than 100 KBs, you may proceed with converting the .WAV into a .son.



• This	will	fill	in	the	output	file	name	in	the same directory
as	the	input	file	and	update	the extension to .son

• Click	the	convert	to	ADPCM	button,	and	you will	see
the	new	file	appear	in	the	directory.

• Now	run	the	ADPCM	converter	from:
C:\visar\bin\AdpcmConverter.exe

• This	program	converts	the	file	into	a format
the dialer can play back.

• Click on the browse button
next	to	“Input	File”.

• Navigate to the previously recorded
message and select open.

2.1c: Conversion



• Go to File > Configuration Menu

• Select 'IP'

• In the field, type in the IP Address of the target module. In this instance, we are connecting to the Dialer, 192.168.1.100.
The factory default address is 192.168.1.100 This is the IP address of the Communicator

• Leave everything else be and click 'Ok' to refer back to the Main Screen.

• Enter the password '33333' (five 3's) in the 'Password' field.

• Click the 'Connect' button.

• Once connect, the text in the console area will turn red and the message 'Connected...' appears.

• Next, at the Main Screen navigate to the 'Digital Amplifier' tab, then click on the 'VoiceMessages' icon.

• This will open the Voice Messages window.

• After the first five Messages, under
'Start of Station Messages', you can
scroll through the individual available
audio files. This is also how you can
select and upload custom messages
to certain Remote Call Stations, for
instance, the locations of these
Remotes.

• Click 'Load Directory'. All of the
recorded messages in the
C:\visar\umessage folder will be listed.

• Once complete, click 'Ok'.

2.1d: Upload Messages

Now it is time to run the Down Program and configure the device. Execute the DOWN Program from the Desktop Icon. Instructions for installing the Down 
Program may be found in the SHIELD30-DOWN-Program-Installation-and-Setup-Guide which may be found in the Dropbox: 

https://www.1sae.com/lifeguard-networks

First, we must connect to the Communicator, the module that connects directly to the phone line. 
This is the module the messages will be uploaded to.

©2023   Space Age Electronics, Inc.

Main Screen Configuration Menu

Note: If you choose to select one 
Message, any blank fields will not 
remove the corresponding Message on 
the Dialer.



• Next, click the ‘Send User Voice’ button.
This will upload all of the messages to the Communicator.

Note: During upload it will 
scroll through the packets 
being sent for each file. This is 
a good indicator all is working. 

•Once	complete,	errors will appear. This is normal.
      Press	‘Close’	   and   	‘OK’	on	the	final dialogue boxes.

If 'File xx of xx' exceeds the number of messages you 
are uploading (in this case 38 of 36), then the uploading process was a success!  

Once messages are uploaded, the Communicator will immediately use them.  Resetting the device is not required at this time.

Note: During upload, it will 
send each file one after 
another. The Download Status 
dialogue box will pop up after 
every file has been upoaded. 
Do NOT click any dialog boxes 
until it completes all files.



0 
1 
2 
3 
4 
5
6
7
8
9
10
11
12
13
14
15

'Emergency Communication System has been activated' 
'Clear to Talk'
'Now Listen'
'End Call'
Trouble Message
Instructions
'Three'
'Four'
'Five'
'Six'
'Seven'
'Eight'
'Nine'
'Ten'
'Eleven'
'Twelve'
'Thirteen'
'Fourteen'
'Fifteen'
'Sixteen'
'Seventeen'
'Eighteen'
'Nineteen'
'Twenty'
'Twenty-One'
'Twenty-Two'
'Twenty-Three'
'Twenty-Four'
'Twenty-Five'
'Twenty-Six'
'Twenty-Seven'
'Twenty-Eight'
'Twenty-nine'
'Thirty'

16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33

2.1e: Upload Messages with Number Announcement 

Uploading messages with the number announcement is very similar to the previous 
method, except selecting the additional messages. Note the order is critical:

File Name  Message



There is an option to quick load messages to the Voice Messages list in order to save time. 

Within the folder, there is a 'voice.ini' file. Open 'voice.ini' in Notepad. You may delete any of the 
audio file names already written on there and replace them with your own. Make sure to write '.son' 
at the end so that the Down Program knows it is searching for an audio file.

Save the 'voice.ini' file, then launch the Voice Messages menu in the Down Program.

On the right, click 'Load Directory'. Audio files should start populating the blank spaces!

Note: The first six messages (0 - 5) are for phone instructions and operation. The remainder are 
individual stations. You may change these to represent the location the Remote is residing.

2.1f: Quick Load Messages

©2023   Space Age Electronics, Inc.            Document: LT10799  Rev A 



In the following Example, the IP address of the Master is 
192.168.1.90 /1025

And the IP address of the Communicator is: 
192.168.1.100 /1025

The system-Dilaer-Default-100.cfg of the Communicator includes:

/MEMBER_IP and /VOICE_IP 
Defines the CP on the network. Multiple CP's may be defined to use a single dialer.

/SYSTEM_POLLING 
Should remain un-touched. 
/DIAL_NUMBER 
Must be updated to the target for the site.
/DIAL_WAIT 
the number of seconds the dialer will wait to call out on the POTS line if the Command 
Panel does not acknowledge the call coming from a Remote Call Station. This may be 
from 1 to 1800 seconds.

/LINE_IN_DB_AUDIO * Set to default,* only change if necessary
This function allows the input volume to be adjustable. (0 - 32)

/VOLUME_HP_PERCENT  *Set to default, only change if necessary
The amplitude of the audio transmitted to the POTS phone. unless necessary, this should remain at 125 

2.2: Configuration Files 
2.2a: Description

The Communicator uses a Configuration File (.cfg) to configure the IP address of the Master and Communicator defaults. 

The Communicator may be connected directly to the Master or through a standard Ethernet network. If it is necessary to configure through a firewall, 
the default port is   UDP - 1025.

Note: Both functions /LINE_IN_DB_AUDIO and /VOLUME_HP_PERCENT use logarithmic numbers, not linear!
Note: An ‘x’ after any backslash will comment out the line, disabling that function, as shown in this  example.  

See (Sections 1.3, "Contact-ID" and 2.2b, "Configuring the System") for Contact-ID Example.
All of the Configuration Files are available for download. See (Section 8, "Resources").

There are additional functions that can be used in the Configuration Files. 
These functions include: Note, Changing any of these settings is outside of the UL 

/DTMFDURATION 125
Duration of dial tones.

/DTMFMARK 125
Duration of time between dial tones.

/DTMFAMPLITUDE 110
Volume of dial tones.

/DIAL_PERIODIC_REPORT_PERIOD_MINUTES 10 
The Command Panel will dial the Central Station every 10 minutes to check in. See 
(Section 2.2b, "Configuring the System") for one set to check in every 24 hours.

/NUMBER_OF_VOICE_LOOPS_BEFORE_DTMF
The number of times required to listen to the informational and instruction 
messages when answering the phone line before they can be interrupted to start 
the call. If set to 1, the phone operator can immediately interrupt the messages any 
time by pressing the * key. If set to 2, the operator must listen to the messages all 
the way through at least once before they can be interrupted. Any greater than 2 
adds an additional loop before the messages can be interrupted. 

/xDISABLE_TROUBLE_TRANS_DIALER
Disables Trouble errors at the Command Panel in relation to the Communicator.

For a visual diagram of how the '/DTMF' functions work in the system, refer to (Second 2.B in the Down Program Configuration and Setup Guide.)



2.2b: Configuring the System

Configuration for the Master
The systemMaster_90.cfg of the Command Panel:

/MEMBER_IP and /VOICE_IP
Defines the Communicator address. The SUPERVISED tag 
tells the Master to supervise the Communicator and Report 
an error event if the Communicator goes offline or if the 
phone line is un-plugged.

Note: without the ‘SUPERVISED’ tag, this is the default 
configuration for the Command Panel. You should not need 
to adjust the Command Panel's Configuration File except to 
add the 
‘Supervised’ tag or change IP settings from default.

Note: If changing the IP addresses of either module, update 
the /MEMBER_IP and /VOICE_IP in the configuration files to 
match the new IP Addresses. Also perform this task when 
working with a setup using multiple Command Panels and/or 
Relays.

Note: Uploading the Configuration Files to the modules will 
not be possible without the device connected to a phone 
line!

21/50



•Using the Down Program connect
to the target device and select
‘Send General File’.

•Use the browse button to
select the file.

In the dialog box select the ‘File•
Name Translation’ and choose
‘system.cfg’ from the pulldown. then
press the “OK” button.  Wait for the
dialog to pop up for “Download
Complete”.

•Once complete, click 'Disconnect' and then select ‘Reset Device’  to have it read in the
new configuration. A hard reset (turning the power off and on) is also recommended.
Repeat this process for the other module.

Note: Using system-Dialer-Default-100.cfg and systemMaster_90.cfg is 
recommended. 

If multiple Command Panel devices are being used, label each device's 
Configuration Files to match its designated location.

Example: “systemMaster_Airport_90.cfg”

For an example of a Multi-Command Panel setup, refer to 
(Section 2.4b, "Multiple Command Panels Setup").

2.2c: Upload Configuration File via the DOWN Program

Each configuration should be uploaded to the associated device.  
When saving the files, any name is acceptable as long as it uses the .cfg extension. 



Labeling Remote Call Stations

Create a .cfg file and using the 
/MY_LABEL function, type in the desired name for the target Remote Call Station. 
The name must be typed in two quotation marks;  

 "Lobby".

To meet the minimum file size requirement to upload this file, do not remove these X's!

• Going to the DOWN Program, navigate to

• File > Configuration Menu.

• Connect to the Master Module, then type in the number of the Remote
Call Station you would like to label based off of its DIP Switch Node. In
this example, we will be connecting to Station 6.

• Check 'Send to RS485-node', then hit 'Ok'.

• Back in the main screen, hit 'Connect', then 'Send General File'.

• Click on the three dots to the left and search for the Configuration File
you had just created.

• Referring back to the Download File window, check
'File Name Translation Enabled', then select 'Ampli.cfg' from the drop-
down list and hit 'Ok'.



Label downloading... 

Download Completed!

Once finished, close the Download windows and 
restart the device. 

Referring back to the main screen, reconnect to 
the Remote Call Station and hit 'Explore Devices'.

In the Explore Devices screen, hit 'Start Scan' and 
wait for the DOWN Program to load all the 
connected Modules in your setup.

Command Panel View
After pressing '6' on Main Screen

Explore Devices View

Labeling Remote Call Stations (Continued)



2.2d: Creating Configuration Files

When creating Configuration Files for your 
Device, it is important to note the file extension. 
With File Name Extensions turned off, the file 
extension can still be seen in the top-left corner 
of the notepad. 

When saving, be sure to switch the "Save as 
type:" from "Text Documents (.*txt)" to "All Files 
(*.*), then type in ".cfg" at the end of the file 
name.

If you wish to turn on File Name Extensions, 
open File Explorer, click "View" towards the top 
of the window, then check "File name 
extensions."

With this feature on, you can also change the 
file extension without needing to open it. This 
method can be done both on the desktop and 
the file explorer.

Right-click on the file, select "Rename," then 
replace its original file extension with the 
desired one.

Note: Windows will give you a warning popup 
informing that changing certain files this way 
could corrupt it. This is not a concern when 
dealing with .txt and .cfg files.

For best practices, we recommend creating a 
folder either on the desktop or in the "C:/Visar" 
folder to store the Configuration Files.



Master Module =  IP ends with .90, Named SM30_xxxx 
Communicator Module = IP ends with .100, Named SCOMM-xxxx

Note: If the device is pinging but not connecting to the Down Program, we recommend contacting your IT Technician.

If the device is not connecting to the Down Program, not pinging to the computer, and the IP on the target module is not certain, it's time to 
reset the IP address

2.3 Updating IP Parameters

This chapter goes over the steps of changing the IP address(es) of your 
SHIELD30 Emergency Communication System. 

Changing the IP Address is recommended when working with multiple Command Panels, or if an unrelated device is 
already occupying that IP Address.

 Identifying IPs via CMD Prompt

IP MAC Address



Opening the DOWN Program, 
type in the password, "33333",
then navigate to:
File > Configuration Menu.

Configuration Screen on the Command Panel. This 
screen can be found under:
Menu > Config.

As we can see here, this Command Panel's IP Parameters are 
currently set to its default, 192.168.1.90

Connect to the desired Module you wish to change the IP 
Parameters of.
In this example, we are connecting to the Master Module. It's 
currently set to its default IP, "162.198.1.90". 

We want to change the end of the IP address from ".90" to ".94".

Click "Ok".

Back in the main screen, click 'Connect', then select the 
'Gateway' tab towards the top of the screen.

Default MAC and IP 
Master Module

2.3 Updating IP Parameters (Continued)



While connected to the device, select 
'Get Main Configuration'.

A window saying "Configuration Uploaded" 
will appear. 
Close it, then select the TCP/IP button.

In 'IP Address', type in the new 
desired IP.

You may also change the 
Transmitter ID, which is the 
name of the Communicator 
Module. This name can be 
found in the DOWN Program's 
main screen and the Device 
Scan.

Make other changes as 
necessary to your setup.

Once finished, click on the 
'Download' button.

When updating IP Parameters 
to the Master Module, it takes 
approximately 65 seconds total 
for the changes to finish 
uploading. Within 12 seconds 
of uploading, the Command 
Panel will reset itself.

Note:
Currently, in
DOWN Program version Jan 18, 2022,
there is a visual error which reads
"Download FAILED! Check Password!"
This is only a visual bug in the program and has 
no functional effect on the system.

2.3 Updating IP Parameters (Continued)



Once the changes have finished uploading, close all 
the Download and TCP/IP windows and refer back to 
the main window.

Check the Command Panel and refer to its 
Configuration Screen to see the updated IP.

You can also check by entering the 'arp -g' command 
using the CMD Prompt.

Go into the Configuration Menu and switch to the new IP Address.

Note: Whatever changes are being made to the IP Address must also match in their Configuration Files!

Default Communicator Configuration File Modified Communicator Configuration File

2.3 Updating IP Parameters (Continued)



5.1: Uploading Messages (Summarized)

1. Launch the DOWN Program and Connect to the Communicator Module
a. The Messages get stored on the Communicator Module while the Master Module

handles their execution.

2. Navigate to the Digital Amplifier > Voice Messages icon
a. Select each individual field and assign Messages to their corresponding Station

Number,

       OR...
b. If quick-loading Messages with the Voice.ini file, select "Load Directory" and wait for

the list to populate with all messages written in that file.
i. Note: Messages 0 - 5 are reserved for Announcement and Instructions. The

order is critical!
c. Select "OK and refer back to the Digital Amplifier tab.

3. Upload the Messages to Communicator
a. Select "Send User Voice". A dialogue box will pop up. select 'OK' to continue.
b. A message will appear every time each file has been uploaded to the Communicator.

Leaving these windows alone will not stall the uploading process, so they can all be
closed at once when finished.

5.2: Uploading Configuration File (Summarized)

1. Launch the DOWN Program and Connect to the Target Module
a. Master, Communicator, Remote Processor (RCS)

2. From the Main Menu, select "Send General File" and search for the appropriate
Configuration Files (.cfg) that goes with the correct Module.

a. At the "Download File" window...
i. If uploading to Master, Remote Processor and Communicator Modules, select

"TSD -> system.cfg, main.cfg" from the drop-down menu,

OR...
ii. If uploading a Label to Remote Processor, select "Amplifier -> Ampli.cfg

from the drop-down menu.

b. Select 'OK' and wait for Configuration File to upload.
c. Once finished, restart the Device or specific Module.
d. If uploading a Label to a Remote Processor, check to ensure successful upload by

either referring to Explore Devices > Scan Device in the DOWN Program, or refer to
the Command Panel and select the corresponding Station Number from the Main
Screen.

This section goes over all the previous steps in a condensed format.
For visual steps, refer to Sections 2 thru 4.

5. Summarized Workflows



LifeGuard NE Two R Ks Sequence of Operation 
Central Station Operator's Copy 

SHIEL.030 

This sheet is a part of the 
SHIELD30-Communicator Configuration Instructions 
manual. For further documentation, visit our website 

or scan the QR code on the right.

Call Sequence: ( Non contact-ID ):
1. Call from Remote Call Station is placed.
2. Communicator dials number in Configuration File.
3. Operator picks up call.
4. Communicator in Command Panel starts playing Message 0, followed by Message 5.
5. The minimum required Voice Loops will force the Messages to play a certain number of times before they can be

interrupted before proceeding the call.

6. Operator listens to message and uses asterisk ' * ' key to talk.
7. Operator communicates with user at Remote using the ' * ' key. Each time the ' * ' is pressed the Operator hears

Message 1 if they enable Talk, or Message 2 if they enable Listen.
8. Operator presses' 1 ' key to stop communication. Message 3 is played. Operator presses'1'key again to acknowledge

and end the call.

 

Note: If the' 1 ' key is not used to confirm ending the call, the 
system will re-dial the number until the call is acknowledged. 

Note: These messages will repeat if no input is given. 

*Voice Loops:
The number of times required to listen to the informational and instruction messages when answering the phone line before they can be interrupted
to start the call. If set to 1, the phone operator can immediately interrupt the messages any time by pressing the * key. If set to 2, the operator must
listen to the messages all the way through at least once before they can be interrupted. Any greater than 2 adds an additional loop before the
messages can be interrupted..

www.1sae.com 
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